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CHAPTER ONE 

 WHY iRECORD? 

Wildlife recording can be a fascinating and rewarding activity. iRecord can not only make wildlife recording even 
more enjoyable but can also make your recording efforts become much more worthwhile.  Biological recording is 
not just about having fun, as good quality biological records are essential to inform everything from planning 
decisions to political policy to scientific research and practical wildlife conservation.  At its most fundamental level 
wildlife records are collected on paper or in digital form such as a spreadsheet.  It’s all too easy for the records to 
get forgotten about and left exactly where they are; the records are then not available for anything.  By using an 
online recording system like iRecord you can easily: 

• Share your sightings with the recording community 

• Explore dynamic maps and graphs of your data 

• Ensure that your records are available to appropriate organisations and therefore make a real contribution 
to science and conservation. 

Online wildlife recording presents lots of new opportunities: 

• Sharing records is simplified to the point that the recorder need not actually do anything other than add 
their records to the system. Records can be easily shared with other recorders, local record centres and the 
NBN Gateway.  There is no updating of software or checklists. 

• By sharing our records, we can learn from the experiences of others such as what is being recorded on our 
patch by others, what identifications are being verified by experts and so forth. 

• By sharing our records, we can get rapid feedback from experts and other recorders on record quality issues. 

• By sharing our records, we can ensure our records are of maximum value and not just known only to 
ourselves. 

 

Tip: iRecord’s philosophy is that sharing of non-sensitive records is a fundamental part of wildlife recording. In fact, 
unless there are sensitivity issues relating to a record iRecord makes records available for public interest and to 
support nature conservation. iRecord is not the right tool for you if you want to keep a private list of records! 

 

There are a number of YouTube videos showing how to ‘do’ iRecord.  Go to YouTube and search for something like 
‘iRecord biological recording’.  A simple search on iRecord will unfortunately bring up lots of videos on a sound-
recording app with the same name! 
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CHAPTER TWO 

USING TRAINING MODE IN iRECORD 
 
Register on iRecord 

Before starting any work using iRecord, make sure that you have registered a user account and can log in. You can 
do this via the links from the iRecord home page. 

Whilst learning iRecord, you will want to go through the steps of actually submitting records into the system and 
seeing the results. If you are concerned about putting records into iRecord whilst you are still learning the basics 
then don’t worry as iRecord supports a training mode. Whilst in training mode: 

• the records you add are flagged as training records so they won’t be sent on to experts, local environmental 
record centres or the NBN Gateway. 

• training records are hidden from view for all users of iRecord unless they are also in training mode. 

• filter the reports you see so that you can see the training records. 
 

To enable training mode, follow these steps: 

1. Click My Account from the link in the top right of the screen. 

2. Click on the Edit tab. 

3. Click on the Preferences tab. 

4. Scroll down to the ‘Who you are’ box and click on ‘What you record’ 

5. Tick the checkbox next to ‘Training’. 

6. Scroll to the bottom and click the ‘Save’ button. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://www.brc.ac.uk/irecord
http://www.brc.ac.uk/irecord
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The following screenshot shows the My Account link, Edit tab, What you record tab and Training checkbox: 

 

Once you are in training mode, you will find that a message is displayed at the top of each page warning you. You 
can see from the following screenshot example that the records visible on the home page were those which were 
previously input whilst in training mode.  

 

Don’t forget to unset the training option when you want to start inputting live records! When you do 
this, your training records will remain in the system but will be hidden from your view until you choose to return to 
training mode. 
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CHAPTER THREE 

WHERE DOES THE RECORD GO? 

One of the big benefits of iRecord over written records and some other computerised recording systems is in 
relation to where your records go after you submit them. Many recorders are motivated to record wildlife because 
they want to ensure that records are available to decision makers, planning authorities, scientists, recording 
schemes and societies. Records on paper need considerable effort to get them into a form where they can be 
utilised. Even records in spreadsheets take considerable effort to import them into the databases used to collate 
records, since species names and other terms all need to be matched with the correct equivalents in the database. 
This might sound trivial but don’t forget that many species names are not unique; a redshank is a plant or a bird for 
example. A combination of the effort required to process records and the lack of awareness of the importance of 
collating records means that many records remain exactly where they started out - on paper or on a spreadsheet. 
This is even true of many records collected from that most modern of recording phenomena, the bioblitz; the 
effort required to mobilise the data is often considered not worth it. Of course that’s not to say that we shouldn’t 
hold events purely with the aim of public engagement, but with iRecord we hope to make mobilising records much 
easier so there are no good reasons not to. 

iRecord helps you to match species names correctly at the point of data entry by showing you the common name, 
latin name and species group when you pick a name, so issues with matching names are no longer a factor. The 
record is immediately in digital form with correctly input grid references picked from a map, no ambiguity in the 
way dates are written and so forth. Therefore fully utilising the records which are input into iRecord becomes 
much simpler. Creating an accurate record right from the outset is only part of the story, so lets take a look at what 
else happens next behind the scenes. 

The Database 

All records added to iRecord go straight into a database hosted by the Biological Records Centre known as the 
community warehouse. This name reflects the fact that the database is shared with a community of other online 
recording websites for reasons which we will come to later. The records are held securely and are regularly backed 
up. 

Records are immediately available 

All non-sensitive records added to iRecord are immediately available for browsing on the Explore pages of the 
website. Local environmental records centres have instant access to records, to ensure that they are not 
overlooked in the local planning process while they are waiting for verification. Of course, a record needs to be 
verified before it is used as evidence for decision making, but instant access to unverified records can help ensure 
that important species and habitats are not harmed due to lack of awareness of their presence. 

Automated checks 

Records added to the database are subjected to a number of automated checks. For example, if a record is outside 
the expected distribution of the species or at an unexpected time of year, then a flag is added to the record 
marking it as such. These flags shouldn’t be considered as an indication of a “bad” record though - a record which 
is outside the known distribution is exactly the sort of record which can show the movement of a population if 
enough evidence is available to verify the record. 

http://www.brc.ac.uk/
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The rules used for the automated checks are imported into iRecord’s processing systems from the NBN Record 
Cleaner, an application designed to help experts quickly verify records. The parameters used for the rules 
themselves are authored by the relevant recording schemes. 

Expert Verification 

The next, critical step in the journey of the record is a review by an expert. Only expert verified records can be 
used as evidence in planning enquiries, species atlases etc. That doesn’t mean a record that cannot be verified is 
not useful; even if it only gives guidance for further professional surveying - every record is valuable. 

Experts have access to a list of the records pending verification, which is filtered to their region and taxonomic 
speciality as appropriate. They also have tools to quickly verify records (for example you can verify en masse all 
records of common, easily identified bird species by trusted recorders).  Photos uploaded with records are often a 
great help in verifying records of some species groups but in many cases the expert needs to contact the recorder 
to check further details or to ask if a specimen is available.  iRecord’s verification system includes tools to make all 
these tasks as simple as possible for the expert so that they can concentrate on the important task of checking 
through the records. 

 

The above screenshot shows the verification system in iRecord. Notice how the verifier is able to verify records 
from multiple places from a single screen - in this case, iRecord, Norfolk Biodiversity Information Service and the 
Bees, Wasps and Ants Recording Scheme. 

Chapter 20 has some further notes on Verification. 

  

http://www.nbn.org.uk/record-cleaner.aspx
http://www.nbn.org.uk/record-cleaner.aspx
http://www.nbn.org.uk/record-cleaner.aspx
http://www.nbis.org.uk/
http://www.bwars.com/
http://www.bwars.com/
http://www.bwars.com/
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Records are passed to the NBN Atlas 

The NBN Gateway is the UK’s portal for exploring biodiversity data, a node of the Global Biodiversity Information 
Framework (GBIF). All verified records from iRecord are shared via the NBN Gateway in datasets administered by 
the relevant recording scheme, local records centre or survey organiser. From there, the records are made 
available to a number of other websites via NBN web services, and to an international audience via GBIF. 

 

The NBN Gateway makes iRecord records available for public interest and to support nature conservation. The 
records may not be used for research and commercial purposes without written permission from the dataset 
administrator. 
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CHAPTER FOUR 

MY ACCOUNT 
iRecord allows you to customise several aspects including the species groups you like to record most often and the 
region, county or area you most often record in. These are then used to customise reports and can also be used to 
simplify data entry or to bring to your attention any recording forms which might be of interest, so it’s worth 
spending a few moments familiarising yourself with the possibilities. 

To access your account, click on the My Account link in the top right of any page. 

The My Account section is divided into 2 tabs as follows: 

View Tab 

The View tab shows a summary of your settings, for example: 

 

Note on this tab the section called Recording Preferences which tells you what you’re mostly interested in. There’s 
more about this in later chapters.  

Edit Tab 

The Edit tab allows you to change your Log In password and to set your account to allow vague dates (such as ‘July 
2019’ or ‘04/08/2018-10/18/2018’, which are not allowed by default. 
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You can also set the frequency that you receive emails with your notifications.  Notifications are mentioned under 
Verification. 

The Edit Tab is divided into 4 further sub-tabs. The first one is ‘Who you are’ which just allows you to change your 
name.  The important one is called ‘What you record’:  

 

On the ‘What you record’ tab you can set the species groups you are most interested in.  Tick all those you 
regularly record.  You can change these at any time later. 

The third one is ‘Where you record’ where you can select a Vice County where you usually record. When you open 
iRecord you will find that the map is centred on this area.   

Note that the list of locations available to pick from uses the list of Watsonian Vice Counties. These are often used 
in biological recording since they are persistent and not subject to the changes that our list of administrative areas 
are subject to. 

When you have set the options remember to click the Save button at the bottom of the page.  
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CHAPTER FIVE 

GENERAL PURPOSE DATA ENTRY FORMS - 1 

Enter a casual record 
To add a record: 

1. First make sure you are logged in and NOT in Training Mode. 

2. Select Record > Enter a casual record from the main menu. This takes you to the form for general ad-hoc 
records. There are other forms for lists of records as well as forms catering for specific surveys, species 
groups and places which we will learn about later. The top half of this form allows you to set most details of 
the record other than the locality information. 

The screen displays a number of boxes for data.  Five of these have a red asterisk (*) next to them.  These 
MUST be filled in or you won’t be allowed to save the record.  All of the rest are optional, although the more 
you can complete, the greater the value of your record. 

 

3. Record destination – The default is ‘Ad-hoc non-group records.  If you create or join Activities (see later 
section) they will appear here as drop-down choices. 

4. Date. Click in the box beside the Date label and you will see that a calendar panel pops down making it really 
easy to simply click on the correct date. If you need previous months or years then you can use the controls 
at the top of the panel to change the visible month. Obviously future dates are not allowed. 
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So, click on today’s date to set the date for the record. 

5. Recorder name. The Recorder Name field will already been filled in with your name as a default value.  If you 
are entering a record made by someone else, you must add their name here, in the format Surname, 
Forename. 

6. Species.  Click in the box next to the Species label. Start typing the first few characters of a species name, 
e.g. “blueb” to search for Bluebell, Hyacinthoides non-scripta. The list of possible matched species names 
appears below the input box: 

 

 

If the species you are looking for has come to the top of the box then simply press return to select it, or you 
can use the arrow keys to navigate in the list then press return when the species you want is highlighted.  If 
the list is a long one then and your name hasn’t appeared, scroll to the bottom and it may say More 
available… so click on this to see more choices. 

7. Certainty.  Although most records are put on iRecord with a relatively high degree of confidence in the 
identifications, there are many reasons why iRecord should accept less than certain records.  These can be 
Certain, Likely or Uncertain. 

a Uncertain records can still act as a pointer to others who may want to confirm the record 
themselves. 

b An uncertain record as determined by the recorder might be accompanied by enough 
information for the record to be verified by an expert. 

c Most recorder’s like to keep all their records for the sake of completeness, not to have to discard 
the ones that they cannot be 100% certain of. This is especially important to the newcomer recorder 
who might one day be the expert verifying my records. 

Therefore, always set the certainty of your record’s identification as it ensures that the record is not 
misinterpreted or misused. It may also flag up a record for closer attention from a Verifier 

8. Quantity. This category is free text.  Examples include: 1, 2-5, abundant, several, large flock, one clump… 

9. Sex.  Drop-down – male, female, mixed.   
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10. Stage. Drop down.  This is of limited value in this simple table, especially for plants.  Choices are – adult, 
pre-adult, other or can be left blank.  Again, this is a general-purpose form and this field may not be 
appropriate to all records, but where possible set the stage of the organism if you can.  

Note that iRecord does support more specialist recording forms, e.g. the British Dragonfly Society’s survey 
recording form, where the list of options is more specific including Adult, Copulating, Ovipositing, Larva, 
Exuvia etc. 

 

11. Identified By. -Knowledge of who identified a record is a really important piece of information when 
verifying records.  If someone else identified your record for you, this is where you put their name. 

12. Add photo – See Chapter 9 

13. Is the record sensitive – All records are available to all users of iRecord.  There is a tiny risk that some 
people with harmful motives may access data and misuse it.  Some records, for example badger setts or 
rare bird nest-sites may be best kept from public access.  However, you may want not want to lose the 
record, and they will be of great value for researchers, conservationists etc.  To this end iRecord lets you 
BLUR your data for the public.  Whatever grid reference you enter, you can set it to blur the data to 100m, 
1km, 2km, 10km or 100km.  A blur of 10km would be best as this would still allow the data to appear in 
national 10km mapping projects.  Only iRecord administrators and expert Verifiers will see the full data – 
Verifiers only see data for the groups and geographical areas they are responsible for. 

14. Location.  Type in the site name where you recorded the species, or a brief description of the site.  If you 
have created or imported some sites as My Sites, as you start to type their name, they will appear in a 
drop-down box.   

15. Spatial reference. – This is detailed information on the place. You can enter a grid reference, latitude and 
longitude, Irish Grid Reference or Channel Islands Grid Reference. The quickest way to do this is usually to 
scroll down the page till you can see the map, then move the mouse over the map to the general area of 
the record. As you hover over the map, you can see a dotted outline of the grid square which you are 
currently over informing you where the grid square will be set when you click.  If you are using a saved Site, 
the site will already appear in your map window, making things even easier.   

Double-click or roll the mouse-wheel and the map will zoom in so that you can click again to set a more 
precise grid reference.  Repeat this until your grid reference is placed to an appropriate level of precision.  A 
10m grid square is a good aim if you can be that accurate! 

You can also type in the grid reference or Lat/Long directly. 
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16. Habitat – This is a hierarchical drop-down list of habitats.  However, it is quite basic and, in many cases, I 
find that it does not provide a useful or relevant category for my recording.  You can always add something 
descriptive to the Comment box.   

NOTE/WARNING – The habitat box can be quite annoying when you are using sites you have created.  
iRecord will remember the habitat that you chose when you entered the last record for the site.  This is 
something you can miss if you haven’t any habitat data for a subsequent record.   I know I miss it 
sometimes because I don’t often enter anything here so I can end up with ‘bogs and fens’ on a limestone 
hill if a big site has varied habitats! 

17. Comment – A free-text box to add anything that may add value to the record.  Another important use is to 
add information that may help the expert Verifier to ascertain the accuracy of your identification by 
explaining HOW you identified it7.  For example, it might say a specimen was observed microscopically, 
was dissected or that a voucher has been kept if needed.  You can also mention the identification key or 
book used, which may help considerably.   

18. Finally, click the Submit button to save your record. 

 

Important Note – Don’t hit the enter key until you are sure you have finished as that will 
SUBMIT the record. 
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CHAPTER SIX 

GENERAL PURPOSE DATA ENTRY FORMS - 2 

Enter a list of records 
This form is designed for quickly entering a list of records that were collected at the same place, on the same date, 
by the same person. Each record added on the Enter a List of Records data entry form has exactly the same 
information as the Enter a Casual Record form. The big difference is that you only input information about the visit 
once and you use a grid to enter a list of all the records that share the same visit information. Another difference is 
that the form is divided onto 2 tabs, with information about the place you visited on the second Where Was It? 
tab. 

Entering the date, recorder name and visited place information is exactly like entering these details on the Enter a 
Casual Record form. However, the species input grid is different: 
 

 

Inputting records is simply a matter of typing species names into the first, Species column. This matches the text 
you input against the list of known species names, exactly as when you are inputting a single record. Once you 
have input a species name, a new row is added to the bottom of the grid letting you continue adding more species 
records. When you add a row to the grid for a species record, you can also set the following attributes of the 
record: • Certainty 

• Quantity 
• Sex 
• Stage 
• Identified By 
• Comment – There is still an Overall comment box at the end – for example if all records were from an MV 

trap it could go there.  The comment box next to each record allows for specific comments on habitat, 
Identification process etc relating only to that one record. 

• Images (Photos) See Chapter 9 
 
The locality data is on a separate tab/page ‘Where was it?’.  Once you click on this tab, you can’t return to 
your species list until you have put data in all the essential (red *) fields. 
 
USEFUL NOTE – If you want to add more records from this sample later, find one of the records and click the 
Edit icon.  Then below the record you will see ‘View all the records in this sample or add more records’ – click 
this and you can then add more without having to add dates, site data or other shared information. 
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CHAPTER SEVEN 

GENERAL PURPOSE DATA ENTRY FORMS - 3 

Enter records at several places 

Although entering a list of records from one place on one day can be a quick way of inputting lists of records, most 
recording trips involve records from more than one grid square. The Enter Records at Several Places form is 
designed to handle this quickly and efficiently - you can add a number of grid squares to a map and enter any 
number of records you like at each grid square. 

Select Record > Enter records at several places from the menu. This form allows you to easily add records for 
multiple grid squares. Find the right place on the map, by selecting Google satellite using the layer picker on the 
map (the blue cross button near the top right of the map).  

 
 
Use the zoom bar on the left of the map to zoom out or in and you can drag the map around using the mouse.  
You can use the pan and zoom controls on the map to zoom in.  
Select a grid square to input records; the map will slide out of view to be replaced by a grid allowing input of the 
records at this grid reference. 
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Tip: If you record regularly at a site, it really will be worth creating a site in the My Sites feature to make finding 
repeat sites very easy! 
The entry grid looks as below… 

 

We can of course specify additional details for any of these records if required. Click the Finish button to the top 
right of the grid when you are ready to continue to add the next grid square. 

Click the Finish button when you are done. The map below shows an example at this stage. 

 

 

You can continue to add more records at further grid squares and can add extra records to one of the existing grid 
squares. Click the Modify Records button above the map. Note how the instructions just beneath the buttons 
changes to tell you what to do: 

Select the records on the map you wish to change. 

Click on an existing grid square and you will return to the grid view of the records where you are free to add new 
records, details of records or to remove records you no longer want to add.  

Move records - If you wish to move the location of records, click on the Move Records button and the instructions 
now say: 
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Please select the records on the map you wish to move. 

Click on your chosen grid square and the instructions change to: 

Please click on the map to choose the new position. Press the Cancel button to choose another set of records to 
move instead. 

You can zoom the map in (the “ghost” image under the mouse cursor shows you how precise the grid square will 
be when you click). Click on the map just to relocate the square.  

 

Modify records – If you have made a mistake, or wish to add something further, click Modify Records and the 
original record entry table will appear.  You can then add more or edit existing records. 

Delete records – clicking on this will let you select a square to delete.  It will ask for confirmation before you take 
this drastic action! 

 

 

 

 

  



 

20  -  Steve Garland, iRecord Training - 2019 

CHAPTER EIGHT 

DATA ENTRY TIPS 
Data entry in iRecord is designed to be as quick and intuitive as possible, but there are a few tips and tricks which 
can make things even easier.  

Control locking 
There are little padlocks next to many boxes.  If you click on one, they lock as below. 
 

 

Try it with the lock by the Date, the date control is now greyed out and the padlock locked, indicating that the 
control value cannot be changed. Try clicking on the date control and you will see that it no longer accepts input. 
The real value of control locking is the control’s value will be remembered the next time you use this form. So, we 
can use this facility when we need to input several batches of records which share some of the same attributes 
such as the date, place or recorder. 

This works in the same way for all fields with padlocks. 

Inputting lists of species 
Choose Record > Enter a list of records (for a site on a date). 

 

Tip: Don’t forget that you can use the tab key to navigate forwards in the form - this is a standard feature of web 
browsers. Shift tab allows you to navigate backwards. 

 

Here are a few names of species that can be entered: 

• Lords and ladies 

• Dog violet 

• Greater-Spotted Woodpecker 

• Parus caeruleus 

• Magpie 

It is worth exploring a few of the different issues relating to finding species names to get a clearer understanding of 
how it works so you’ll be able to find names quickly and efficiently. Type “lords and” into the species name box. 
Your search is sent to the server and used to lookup possible species name matches as follows: 
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This is an interesting (i.e. deliberately chosen) example. 3 results are shown, but they are all for Arum maculatum, 
i.e. Lords-and-ladies or cuckoo pint. The reason is that iRecord uses the UK Species Index to provide species names 
and the UKSI lists 3 variants of the common name Lords-and-ladies with different capitalisation. Another 
interesting point here is that there are hyphens in the common names listed and the names were found even 
though we didn’t include the hyphen in the characters we typed. 

 

Tip: iRecord doesn’t care about punctuation and other special characters when you search for a species name, so 
don’t bother typing them. In fact, spaces are also ignored - typing “7sp” is enough to find “7-spot ladybird” and 
would also find 7 spot ladybird if it were listed without the hyphen. 

 

Another way to select a species name uses an abbreviation of the scientific name - Type “armac” which is 2 letters 
from the genus name and 3 letters from the species name.  This should find the species for us as iRecord supports 
2+3 letter abbreviations as used in some other recording systems.  However, as there are quite a few species with 
the same abbreviation, Arum maculatum does not make it to the top. One way around this is to limit the search to 
flowering plants, which is particularly useful if entering a list of many flowering plant records. 

 

Tip: When using 2 + 3 letter species name abbreviations, utilise the filter button in the Species column header to 
limit your search to the appropriate species group(s). This works even more effectively when entering species from 
a not-so-extensive group as flowering plants. 

 

To change the species names filter, click the filter button in the column header of the Species column. This pops up 
a dialog box allowing you to configure what names are available in the search filter. Select the option Input species 
from the following species group then in the associated drop-down box choose flowering plant. 
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Click Apply. Now, clear the species name input box and type “armac” again. This time you will find that Arum 
maculatum appears in the list a couple of places from the top. Use the down arrow key to move the highlighted 
name down, then hit the return key to select it. 

The species name is selected and a new row is automatically added to the grid. Note that the input cursor is put 
straight into the new box in the Species column ready for you to continue typing species names. Let’s try the next 
name in the list, written as “Dog violet”. Type this name in. Nothing is found - you can tell this because the rotating 
“searching icon” appears briefly and then disappears, indicating nothing was found. One thing to bear in mind 
about using the UK Species Index to lookup species names is it does not understand the vagaries of the ways that 
we often share names. There are actually many dog violet species; we happen to know that Fred meant common 
dog violet, because we know Fred would have specified if it were something different. But iRecord can’t make 
these assumptions for you. If you can’t find a species name because you know that there is a part of the name 
missing, then insert a * character as appropriate to act as a wildcard. Insert a * at the start of the species name 
input so you are searching for * dog violet and you will find that a number of dog violet species are returned with 
common a little way down the list. Select it and we’ll move on. 

Now that we’ve input the plants from the list, click the filter button again and this time set the filter to “Birds” and 
click Apply. 

Since we know that iRecord does not care about capitalisation, spaces, or punctuation, type “greaterspottedwood” 
into the next Species search box. Again, the name is not found (I did say we’d be deliberately looking for problems 
to learn how to handle them!). You might have noticed that we are searching for “Greater” instead of “Great”, but 
assuming that we hadn’t spotted this problem in the name we’ve input, a good way forward would be to search 
for something like “great*woodpecker”, since we know that at least these parts of the name are unambiguous. 

 

Tip: The * character is your friend when struggling to find a species name. 
 

The next species for input has the latin name Parus caeruleus. Input this name and the name will not be found. 
This is because P. caeruleus is the name used for Blue Tit until a few years ago, when taxonomists realised it was 
not actually in the same genus as Parus major, the Great Tit.  So, now it is known by the new name Cyanistes 
caeruleus, though the previously used synonym is sometimes still in use. We don’t want to look up the correct 
name to use every time this happens, so another option is to enable searching for synonyms. To do this, click the 
filter button in the Species column header again. This time, change the drop-down option for Choose species 
names available for selection to All names including common names and synonyms. In other words, all the names 
available in the UK Species Index become available for searching, whether they are current or not. Now retype 
“Parus caeruleus” and you should find that this time, the name is found. 

As one more illustration of grid-based name input, try inputting a few dragonfly and damselfly names to examine 
the most efficient key strokes. The list we will input is: 

• Beautiful agrion - Calopteryx virgo 

• Common Darter - Sympetrum striolatum 

• White-Legged Damselfly - Platycnemis pennipes 

Clear the species names you have input so far, and try the following key strokes as quickly as you can: 

cavir<return>systr<return>plpen<return> 

If you are a quick typist, you will notice that iRecord lets you start typing the species name for the next row before 
it has looked up the first row’s name. You don’t have to wait for the species name to be matched, just get on with 
typing names as fast as you like. This works for common names and latin names as well as abbreviations, though 
you are obviously more restricted in the speed you can reach. For the last abbreviation, “plpen”, iRecord could not 
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find a unique species name match so the drop-down list of possible matches is shown. At this point you have to 
break your flow to click on the correct name. 

Now, try the same experiment again, but type the following set of characters. Note the missing p in “plpen” which 
is our pretend typo. 

cavir<return>systr<return>plen<return> 

This time, if you managed to press return before the search completed for the misspelt “plen”, then you will notice 
with a “polite shake of the head” the species name input box informs you that it failed to find any matches. Time 
to go back and correct it! 

 

Tip: Practice using the keyboard only to input species and associated attributes into the input grid. In time it will 
become intuitive and is faster than using the mouse.  Do this in Training Mode if you feel more comfortable. 

 

One more thing, try typing “cavir” into the species search box then pressing <tab> instead of <return>. This time, 
the species name is picked but the input focus moves to the next control in the same row. You can then use the up 
or down arrow and return key to change the certainty of the record, or press tab again to change one of the other 
column values. Press tab a few times to move to the next row when ready to add a new species name, or shift tab 
to move backwards. When you are in a text input box (such as Quantity, Identified By or Comment you can use the 
up and down arrows to navigate between rows, though the web browser reserves these keystrokes for selecting 
items when the focused control is a drop down. 

 

Tip: Don’t forget to use the record certainty attribute to mark-up records which you are not certain of the 
identification for. Also, note that if you are not certain of an identification to species level, but are certain of the 
genus you can always add a record at genus level. 
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CHAPTER NINE 

UPLOADING PHOTOS 
The ability to attach up to 4 photos to each record added via the grid is accessed via the add images link in the 
rightmost column of the grid.  It’s simply a matter of picking an image file from your disk to upload. 

The file upload system used by iRecord examines the capabilities of your web browser to determine the best way 
to upload files. For example, if you are using a modern web browser with support for the latest standards, then it 
can resize the image so that the upload time is fast and show a progress bar for the upload. If you are running an 
old browser which does not support the latest web standards, then it will do a standard file upload which will be 
slow. If you are uploading multiple images for a batch of records, then a slow upload speed could become 
completely unworkable quite quickly. High speed broadband should provide quick uploads in most cases. 
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CHAPTER TEN 

MAP TIPS 
Here are a collection of tips and tricks for using iRecord’s map during data input.  

Map Layers 

Click on the blue + button in the top right of the map. This expands a panel allowing you to choose from the 
various layers available. On the following screenshot, the first 2 are background layers provided by Google and the 
third is an Ordnance Survey map - you can show only one of these at a time. The second 2 are overlays which are 
drawn over the top of the base layer. You can show any combination of these you like.  Because this user has 
identified themselves as working primarily in West Lancashire, the boundary of this Vice County has been added as 
default, but can be unticked if preferred. 

 

Try changing the settings to see what they do. When you’ve finished, click the - button in the panel to close it. 
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Navigating around the map 

Also overlaid onto iRecord maps you will find navigation and zoom buttons on the left hand side. Although 
sometimes handy way is to use the mouse left button to drag the map around as required and to double click on 
the map to zoom in.  

Another way to zoom into a precise region is to hold the shift key, then mouse-drag a rectangle on the map. The 
map will then zoom to show the rectangle.  If you have a mouse wheel, or similarly featured gestures on a 
touchpad, then you can use this to zoom the map in and out. 
 
A third way to zoom the map into a place is to use the search for a place on the map input box on the left to find a 
town or village by name. Try typing “alfriston” into the box then click Search and the map will zoom into the village 
of Alfriston in Sussex, as it managed to find a unique place with that name. If you try searching for a more 
ambiguous name such as “arlington” you will see that you are given a list of possible matching places to pick from: 
(Steve Garland NOTE – this feature has never worked for me!) 

 

7.4.3 Setting a grid reference for your record 

The simplest way to set a grid reference for your record is to click once on the map where you would like the 
record to be. Most of the time this is all there is you need to know. The following points give you some extra 
details though: 

1. As you hover over the map, a “ghost” image of the grid square you are about to pick is shown. This gives you 
a preview of the square size and position. 

2. The more you zoom the map in, the more precise the grid reference will be. The map won’t set a grid 
reference that is more accurate than could realistically be expected from the scale of the map. 

3. When you click to set a grid reference, the map will zoom into the grid reference square giving you a chance 
to click again to set an even more precise grid reference. 

4. If the map is showing the street map base layer, then when you click on the map to set a grid reference and 
it automatically zooms in, if the zoom scale is high enough the map will automatically switch to satellite view 
so you can set a precise grid reference more easily. 

5. If you hold down the + key whilst over the map, the precision of the grid reference is increased 
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CHAPTER ELEVEN 

EXPLORING RECORDS 
One of the key features of iRecord is that non-sensitive records are immediately visible to other users. This allows 
you to see what is being recorded near your patch or by your friends and colleagues. In this section we will take a 
look at the Explore options available in iRecord for browsing existing records. 
 

Exploring my Records 

There are 2 Explore pages accessible from the menus in iRecord - Explore all records and Explore my records. Both 
are the same except that the My records version is filtered to only your own records. 

The Explore pages are divided into 2 parts, a map panel and a data panel as described below.  If you have added a 
recording area to your profile, it will appear and your map will be centred on it. 

Map Panel 

The map shows records that match the current filter; in this case the filter is all records input by me. When you are 
zoomed to show a distant view of the map, a small grid square would simply not be visible so iRecord 
automatically draws a larger circle over the record until you are zoomed in far enough to show the record as a 
proper square. This map image shows the appearance of records when you are zoomed out: 

 

NOTE - Selecting specific records - You can click on the question-mark icon (map, top left corner) then click 
on a square and the list of records will be filtered to include only those from that square. 
 
If you hold the left mouse button down and drag the mouse you can draw a rectangle and then see all records 
falling within that area. 
 
The third symbol in the top right will make your map full-screen, which can help by giving you a larger working 
area. 
 
And on the next page are the same records, shown when zoomed in: 
 



 

 28  -  Steve Garland, iRecord Training - 2019 

 

The larger squares are records with 1km data, the smaller squares are 100m squares, circles are records from the 
iRecord App that were originally input as Lat/Long.  If you zoom in further you would see tiny 10m squares too 
where data had that level of accuracy. 

Data Panel 
Underneath the map there is a data panel which shows a list of records currently loaded on the map: 

 

In this grid, details of the record including any photos are shown. The icon in the ID column gives an indication of 
the record’s quality: 

• No symbol – not yet checked by an expert 
• Red cross - record checked by an expert and not accepted as was unable to verify 
• Two red crosses – not accepted as is incorrect 
• Question mark - record checked by an expert and marked as plausible 
• Green tick - record checked by an expert and considered correct 
• Double green tick – record checked by an expert as correct 
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Verifiers use these statuses in slightly different ways, but generally:  

• Correct – often a picture was attached that allowed the verifier to confirm an accurate ID, or it may be 
that the ID is straightforward and the Verifier knows the recorder is competent.  However, some Verifiers 
use this only for records with proof attached.  This record will go into the NBN database. 

• Considered correct – This may include critical species where the recorder is known to be competent with 
the species, but actual proof wasn’t attached (I don’t post a picture of the genitalia of every critical moth 
species I dissect.  If they are common and easy to ID on genitalia I will have posted at least one picture to 
show my ID, but the Verifier may trust me after that).  Recording schemes often have critical species, 
where they will only accept records with proof.   This record will go into the NBN database. 

• Plausible – Verifiers may use this for common species that are known in the area, but the level of skill of 
the recorder, or the amount of information provided doesn’t provide adequate proof for confirmation. 

• One cross would include photographs where not enough detail is visible for a positive ID, but it could be 
that species. 

• Two crosses mean that the Verifier considers the record to be DEFINITELY incorrect. 

The data panel has four other tabs, showing a list of the species currently loaded; a list of Taxon Groups; a list of 
Families and all associated photos. All of these lists can be filtered to find the information that you need: 
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Explore > My photo gallery 

Your photos can also be viewed from the Explore > My photo gallery menu item provides exactly that: 

 

There are simple filters based on date range and species group to help you look up photos. For more advanced 
filtering options, your photos are presented in tabular form on the other explore pages. 

 

 
 
 
 

 

 

 



 

 31  -  Steve Garland, iRecord Training - 2019 

 
Explore > Species Maps 

The Explore > Species Maps page provides a really quick and easy way to draw maps of the various species data 
held in iRecord.   

REMEMBER – this isn’t a full national distribution map, just those on iRecord, minus any filtered out by you. 

 

Simply search for the species you want to map in the table on the left and use the + button to add a map layer for 
that species. You can: 

• Add up to 4 species layers to the map at once 

• Filter to show only your own records 

• Use the filter row in the top of the species table to search for a species by name. 
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CHAPTER TWELVE 

MY SITES 
The My Sites facility in iRecord is a great way to keep a personal list of sites you regularly record at.  You can 
also add sites selected from a standard list of sites to your own personal list, currently the only sites available 
are the National Nature Reserves but other site types may be added in future. 

Follow through the steps below to add one of your local recording patches to your account. 

1. Select Explore > My Sites from the menu. Click the Create Site button near the bottom of the page to 
start adding a new site on the Site Details page. 

2. Enter a name for your site into the Site Name box. 

3. Use the Search for Place on Map box to search for a nearby town or village. Once you have zoomed the 
map to the vicinity of your site, use the methods of panning and zooming your map until the map 
includes all of your site boundary. 

4. Select the leftmost tool in the row of toolbuttons at the top of the map. This tool lets you specify the 
centre grid reference of your site. Click once on your site’s approximate centre to set this. 

 

Symbol 1 - click on the map to set a location which is then used as the default grid reference for the 
site. 

Symbol 2 – Make the map full screen 

Symbol 3 – Draw a polygon to create a site.  

Symbol 3 – Draw a line to create a linear site 

Symbol 4 – Modify an existing outline.  You need to play with this one as it can do lots of different 
things 

Symbol 5 – Use this to drag the map around 

NOTE – If you are in the middle of drawing a map and you are running off the edge, you can click, hold 
down the button and drag the map.  When you release the button, you will not have added to your 
boundary and can then continue.  (Sometimes you may find that a new point hasn’t been added to your 
boundary when you expect it – this is caused by you slightly moving the mouse by accident.  Don’t worry, 
click again. 

5. Specify a comment for your site to describe it. 

6. Using the map layer panel, switch to Google Satellite as your base layer. 

7. Since our site is a polygon (it could be a linear site), choose the next tool to the right which is the draw 
polygon tool. 

8. Now, click once on the map on a corner of your site. Work your way around the site boundary, clicking 
once for each change in direction of the site boundary to gradually build up the shape of your site. 
Double click to finish once you have completed the boundary. 

My site details form now looks like the following: 
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Press the Submit button to complete the site creation process.  You can now enter records for the site. 

1. Select Record > Enter a casual record on the menu. 

2. Set a record for today’s date and choose any species you would like to record. 

3. In the Location box, type the first few characters of the name of the site you just created. iRecord will 
search against your list of sites and find the matches. When the site name appears, select it. iRecord will 
zoom the map straight in to show the site boundary for you. 

4. Click once on the map to set the grid reference, zooming in further first if necessary. 

5. Set the Habitat as appropriate for your record. Note that this value will be remembered for you the 
next time you record at this site. 

6. Save the record. 

7. Go back to the Explore > My Sites page. This time, click the Explore button beside your site. This takes 
you to the Explore my records page, filtered to show your records from that site. Below is an example 
using Heysham LWT Nature Reserve 

USEFUL NOTE – If you make errors in your boundary you can either: 

• Use the Modify button to modify it OR 
• Just repeat the drawing process again.  At the finish it will ask you whether or not you want to replace 

the previous boundary – click yes and the old one will disappear – the new one will replace it. 
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The next page shows what the My sites page looks like once you have created a number of sites.  Each site 
shows the number of your records, number of species (taxa) and number of taxon groups from that site.  By 
clicking on the column headers, you can sort them in ascending or descending order either numerically or 
alphabetically.  This screen-shot has been sorted to show the sites with the most records first. 

Note also that you can have overlapping sites. 

If you wish to find a site by its name you can sort the columns and use searches including wildcard searches as 
described in Chapter 15 and 16. 



 

 35  -  Steve Garland, iRecord Training - 2019 

 

 

 

 



 

 36  -  Steve Garland, iRecord Training - 2019 

CHAPTER THIRTEEN 

TAXON-SPECIFIC FORMS LIBRARY 
Previous chapters have shown the general-purpose recording forms.  These are quite basic in terms of the 
attributes that you can record with each record, for example you can’t provide detailed life stage information 
in the Stage field since the field’s values are general purpose.  As well as more specialist recording forms, 
iRecord also allows groups, schemes and societies to add forms for their own purposes, with attributes and 
options appropriate to them.  These are available on the Record > Taxon-specific Forms menu item.  As of 
January 2019, they include: Vascular plants (grid recording); Bryophytes; Dragonflies – multiple species; 
Dragonflies – single species; Ladybirds; Moths and Glow-worms.  More may be added as new groups create 
special forms. 

Because of the way that iRecord was developed, adding new custom forms such as these is a fairly simple 
process, so the library of available forms is likely to continue growing. 
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CHAPTER FOURTEEN 

SUMMARY REPORTS 
The Summarise Menu option provides access to some quick and simple ways to view data summaries from 
iRecord. 

12.1 My data summary 

Click on the Summarise > General Summaries menu item to access a collection of reports summarising the 
records you have entered as well as the records entered into iRecord as a whole. 

 

My dashboard 

Summarise > My dashboard shows a graphical summary of your data input over the last year and progress on 
verifying your records.  The Verification progress by week shows exactly that. 
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 39  -  Steve Garland, iRecord Training - 2019 

Survey Summaries (Activities – see chapter 19, p49 for more Activity info) 

Specific surveys which host their records on iRecord sometimes opt to provide a summary page to show 
progress. This might apply to a bioblitz or a survey of a specific site, for example. These summary pages are 
listed under the Summarise > Survey summaries menu item. Here’s the summary page available for Garden 
Bioblitz to 2018 

 



 

 40  -  Steve Garland, iRecord Training - 2019 

CHAPTER FIFTEEN 

Searching records using Filters 
There are two levels for doing this – either ‘Explore my records’ OR ‘Explore all records’.  The main difference 
between the two is that the default start screen for ‘my records’ will include all your records, whereas the 
default start screen for ‘all records’ will only contain the last month’s records.  This is because starting the 
screen with absolutely all records on the database would be extremely slow, due to the numbers.  If you are 
searching ‘all records’ you will almost always want to select a filter to run or create a filter, which will include 
the date period you are interested in – unless you really are only interested in the last month! 

If you are searching ‘my records’ you may also use these filters, but will mostly use ‘Table Column filters’ – see 
the next Chapter. 

Go to the Explore > Explore all records screen.  The map shows dots for all records received in the last month 
only.  They are also listed in a table underneath.  In one month, this can still be 20,000 or more records.  This is 
because the system would run too slowly if it tried to load all the records - at the foot of the Home page there 
is the latest total of records in the iRecord system – 6.6 million on 28 January 2019. 

If you want to extract records for (say) a particular Vice County, site, or for a particular taxa or map reference 
you will need to use a filter.  You can create one to suit your needs and then save it for future use. 

Click on Create a filter on the top right of the bar above the map and the following choices will appear. 

 

 

What lets you choose taxa to include.  This can be done at species, Family or Order levels or using conservation 
statuses, marine or non-marine statuses (useful for Isopods if you only want woodlice or for freshwater fish for 
example) and for Levels (though I’ve never found a need for this yet!). 

Where lets you define a geographic area.  This can be one of your ‘My sites’ or Vice Counties, LRC areas etc.  
Whatever you select – remember to click the ADD button and your selection will appear beside a red X.  
Clicking this X will remove it again. If it isn’t there with a red X, you haven’t selected it.  You can also use grid 
references and even draw a shape on the map to filter records.  These are things you need to play with to see 
which are best for your needs. 

When is set as default at one month.  You can filter by the field record date, input date, last changed date or 
verification status change date.  Think about these to decide which one will give you the records you need.  
You can set dates FROM and TO, or a maximum record age such as 7 days, 1 year, 5 years, 8 months etc.  Click 
APPLY when you’ve finished. 
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Who only lets you choose to tick ‘Only include my records’ 

 

One word of warning.  If you click on Who, you only get to choose to filter ‘Only include my records’.  
My experience is (as of January 2019) that once you have selected that, the only way to return to All 
records again is to reload the whole screen and start from scratch.  This can be annoying when you’ve 
just built a complicated filter.  If you are looking for a specific recorder, the easiest way can be to run 
a filter on another category or categories to reduce the number of records, then to filter on the 
Recorder column, or maybe sort alphabetically in that column. 

I am not sure why this happens, but it is annoying as you would probably use the ‘my records’ screen 
if you are only interested in your own records.   

There is no way to filter out the records of any one recorder or group of recorders from the Filter 
menu. 

Record ID lets you select records by their unique number – this isn’t a feature I use much, but it’s there if you 
need it. 

Quality lets you included or exclude records based on whether or not they have been verified, whether they 
have been accepted, rejected, not yet reviewed and all other statuses and combinations.   

 

Source lets you filter records by their origins, with lists of possible sources under Websites, Survey datasets or 
Input forms. 

If you create Filters from the ‘my records’ screen you get all the above choices, except the Who category. 
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CHAPTER SIXTEEN 

Searching records using Columns  
In both the ‘all records’ and ‘my records’ screens the table of records has headers – these being: 

• ID – the unique record ID code (a long number) 
• Source – how the data was input (includes ‘iRecord | App’;  ‘iRecord | Orthoptera Recording’; iRecord 

| general data and many others 
• Species – the scientific (latin) name of the species recorded 
• Common name – the English name for the species 
• Taxon group – group names, such as insect – true fly (Diptera); centipede; terrestrial mammal; bird 
• Site name – the name entered under ‘Location’ either a formal site name or the free text description 

entered 
• Date – the date of  the recording 
• Recorder – the entered name of the recorder of the record 
• Images – a thumbnail of any attached photos 
• Grid ref – the map reference or lat/long of the record 
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Sorting on a column 

Click on the title of the column (Species, Site name, Date etc).  The column will be sorted into ascending order 
of that column, either alphabetically, alphanumerically or numerically, depending on the content/format of 
the data. 

An upward-pointing arrow appears by the column label to identify the sorted column and an ascending sort.  A 
second click reverses the sort-order to descending.  Only one column can be sorted at a time. 

Filters 

Just below the ID column label is a tiny filter-funnel icon.  This labels a blank row, into which you can type 
search terms.  You can type in a word or part of a word.  If you type ‘formica’ it will bring up only Formica ants.  
However, if you type ‘for’ it will bring up Formica, Forficula and any other species records beginning ‘for’. 

If you wish to search for a word that may not be at the start of the name you can use a wildcard ‘*’ symbol.  If 
you now type ‘*for’ you will still get Formica and Forficula, but also Chloromyia formosa, Chrysopilus 
asiliformis and many others. 

These filters can be combined across a number of columns.  For example you may search ‘formica’, but then 
put Brockholes in the Site name filter.  The list of ant records will now only show those from the Brockholes 
site. 

The wildcard filters work on all columns (including Grid ref) except the Site name and Date columns.  The site 
names can only be filtered by the start of the name (no wildcards) and the Date can only be filtered by year by 
typing either 2018 or 18. 

Sorting from the map 

If you look at the top right-hand corner of the map and click the (?) icon, you can then click on individual 
squares on the map.  The records grid will then show only those records from that square.  You may 
sometimes get a warning box saying that there are too many records to show in the grid.  This is no problem as 
they display over several pages.  You can reduce the number of records by zooming in further and selecting a 
smaller square. 

Sorting and filtering on other Records tabs. 

Similar sorts and filters can be used on columns in the Species, Taxon groups and Families tabs of ‘exploring … 
records’ – to be found just below the map. 
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CHAPTER SEVENTEEN 

WHAT CAN GO WRONG? FAQs 
I made a mistake and now my submitted record is wrong. 
It may be that you clicked the wrong date, the wrong year, got the grid reference wrong or have changed your 
mind about the identification.  None of this is a problem. 

You can only delete or edit your own records.  Go into Explore my records and find the record of interest by 
sorting and/or filtering.  See Chapter 15 on searching and filtering records to find it.  In the unlikely case that 
you know the unique record number, it is easy, but it shouldn’t take long.  If you have just submitted the 
record, then go to the ‘My records’ page and it will be at the top of the list – easy. 

 

  

On the right side are two symbols.  Click the pencil and paper symbol.  This will open the full record.  You can 
now edit the record.  Once you have edited it scroll down and click the Submit button.   

If you want to delete it click Delete record button. 

If you send in an erroneous record from your phone app, you will have to edit it online later.  Once it is sent in 
you can’t edit it in the app. 

USEFUL NOTE – If you entered records using ‘Enter a list of records (for a site on a date) and you got anything 
wrong that is common to all the list of records (for example date) you only need to correct any one record and 
it will automatically correct all of the others.  This is great and can save a lot of time.  If you are worried about 
this, then you can click ‘View all records in this sample’ to see all the others. 

My Records aren’t being verified. 
All verifiers are experts in their field, but are all amateurs with other jobs, roles and responsibilities.  Their 
verification may be limited to certain groups or taxa, or to specific geographical areas – or both. 

Some verify material quickly and regularly; others may do it less frequently as they fit it in around other things.   

Some groups may not have verifiers; other groups may only have verifiers for certain counties or regions. 

If you would like to be a verifier – do contact BRC to discuss how you might be involved. 

My record was rejected as being ‘out of range’ or for other reasons I don’t 
understand. 
The system has some automated processes to flag records that fall outside known ranges or are unusual in 
some way.  These automated systems are primarily there to help Verifiers, especially when some may be 
keeping on top of tens of thousands of records per year!  Be patient – this automated response is only a 
holding response and hopefully a Verifier will process it in due course. 

I have had notifications querying my records, what do I do? 
Notifications may be emailed to you – but new ones are visible at the top left of the Home screen. 
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Click on the ‘You’ve XX unread notifications’ 

The Notifications screen will open. 

 

The top one was queried as the species is not known in the area.  It was an error.  To correct it – click 
on the first (pencil & paper) icon and edit the species, then Submit. 

If you click the second (magnifying glass) symbol you’ll see the whole record, plus the comments 
from the verifier.  You also have a box where you can add you own comment – in this case an 
apology for selecting the wrong name in the iRecord App. 
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I have tried to enter a species name (or my site name) and after ages it hasn’t 
pulled up any names. 
This seems to happen sometimes, often when the screen has had no activity for a while.  Reloading 
the page will usually ‘free it up’ again. 

I have a box saying ‘Leave site? Changes that you made may not be saved’.   
This box is just a failsafe to make sure you are not about to ditch a load of records you’ve just 
entered into a list and haven’t submitted. 

The species I am recording isn’t in the list 
The most likely reason is that you are using an old name.  Scientific names often change as a result of 
the latest research.  Click on the Filter funnel icon next to the word ‘Species’ at the head of the 
column.  The box below will open.  In the lower box choose ‘All names including common names 
and synonyms’ – then Apply.  Your old name will now work.  However, it may be slower as it is 
checking many more possibilities for each entry.  You can easily change it back afterwards to speed it 
up again. 

Alternatively look up the latest name in a checklist or on the NBN Atlas site and use that.   
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The iRecord site won’t load at all. 

Maintenance may be taking place.  Usually major upgrades etc that take down the system are 
notified in advance.  The only solution is to revisit later. 

Sometimes the site seems to be very slow.  I suspect that this is when large data files are being 
uploaded or large tasks being processed.  If it is really annoying you – best to try again later (this 
doesn’t happen often).  
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CHAPTER EIGHTEEN 

TOP TIPS & SOME FUN THINGS 
Filters 

Wherever you see the little Filter symbol  you can click in the white area under the heading 
name and type in terms to filter all the records in the table.  Remember that the * symbol is a 
wildcard.   

The best way to learn about this is to try playing with it in different ways.   

To clear a filter – just delete you search word then hit the Enter key. 

Right click – open in new tab 
Get used to opening new pages with a ‘Right Click’ on the mouse rather than a normal mouse-
click.  There is a very good reason for this.  If you run a filter or sort a table of records and then open 
a record to look, then click the ‘Back’ arrow, the screen will have reset to its initial unsorted or 
unfiltered state, so you would have to start all over again.  If you haven’t saved your filter, this can 
be extremely annoying! 

If you get used to always opening a fresh tab (right click) you will avoid this problem. 

 

Forum 
This is where you can read about new announcements, how to do things, or to report issues or ask 
for help.   

Help 
This is where you can find the online information that is included in this document and quite a bit of 
stuff that isn’t. 

FUN STUFF 

Recorder league 
Click Explore > Recorder league 

This lists all recorders contributing to iRecord, sorted according to either the number of records they 
have entered or the number of species they have entered records for.  Just a bit of fun really – 
unless you are a ‘pan-species recording’ enthusiast with a competitive streak? 
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CHAPTER NINETEEN 

ACTIVITIES 
The Activities menu gives access to a wide range of activities, ranging from national recording 
schemes to one-off bioblitzes.  A number of recording schemes (such as British Dragonfly Society) 
have their own activities, linked to specially-developed data entry forms tailored for their particular 
group. 

In addition, there are many local groups recording a single reserve or area. 

If you are part of a group recording on one reserve, an activity can let everyone join so that everyone 
can share each other’s records and see what has been found.  This is much easier than having to 
filter and sort records from the main database.  You can also add boundaries and areas that 
everyone can use for recording – this is the only easy way (currently) to share site boundaries with 
others.  An activity has to have at least one Administrator and they can set up, and subsequently 
edit, details about the Activity.   

They can add: 

• Activity name 
• Activity description - free text description 
• Activity type – choice of Events & bioblitzes; Local groups; National groups or Recording forms 
• Logo – load your logo if you have one! 
• How users join the activity – Open; on Request or Invite only 
• Activity active from – start and finish date (if applicable) 
• Activity administrators – the founder and any other recorders added as administrators 
• Records that are of interest – lets you filter species or groups; geographical area or dates to include 
• Which records to include in reports – can restrict records to those from members, or include those 

from anyone that fit the Activity criteria (such as a site boundary) 
• Activity pages – These will appear as buttons on the Activity page.  Options include different ways of 

entering records and what sort of data and data analysis various people can see, set to everyone, 
members or administrators  

 

Activities undoubtedly offer opportunities for collaborative working, but at present there are limits 
to its flexibility for most users.   

I suspect that this feature will be developed further in future as a more effective site-management 
tool. (I hope so!) 
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CHAPTER TWENTY 

VERIFICATION 
If you become a verifier there are additional screens that you have access to which allow you to 
Verify records, but this guide is not going to cover that.  Verifiers are people who have expertise in 
particular area of identification, and often also are familiar with a particular area of the country.  For 
example, I verify Neuroptera and allied groups for Cheshire, Lancashire and Cumbria. 

Verifiers are volunteers and do have lives to lead as well!  Do remember this when waiting for them 
to verify your records.  Neuroptera verifiers have hundreds of records to process, but hoverfly and 
butterfly (and other) recorders have tens of thousands to do, so be supportive of them and their vital 
work.  Some verifiers can verify regularly, others may blitz a year of data at one go – be patient. 

IMPORTANT NOTE – not all groups and areas of the UK have verifiers, so some records won’t be 
verified at all at present.  However, the records will sit there and can be verified at a future time as 
soon as a suitable Verifier is available. 

There is a screen grab of a basic Verifier’s page in Chapter 3 (p8). 

Notifications 

If you have notifications, a clickable note will appear on your iRecord Home page (top left) ‘Welcome 
back Steve. You’ve 2 unread notifications’.  

You will get notifications of two sorts – automatically generated ones and from Verifiers.   

Auto checks - The automated ones can cause annoyance if you don’t understand the process.  If you 
record has been flagged as ‘outside its known range’ this probably just means it is a new 10km 
square – a positive thing.  However, it can be useful for the Verifier to see these sometimes as they 
can make spotting real out-of-known-range records easier. The auto-check is just a tool, not a final 
decision. 

Verifier notifications – These are generated by ‘real humans’ and are the important check.  You will 
receive notifications about them.  If records are queried or not accepted, the Verifier may sometimes 
explain why they decided on rejection.  Sometimes they may ask a question before accepting the 
record.  If you have further information, photos or a voucher specimen that could be sent for 
checking, you can tell them.  Verifiers can update ID’s if new information comes to light or if further 
checks can be completed. 

You can open a record to view (using the ‘magnifier’ icon) and see all comments by the verifier.  You 
can also reply or add more information.  You could add another photo and send a note to help the 
Verifier make a decision.  It is sometimes an opportunity to learn, but remember Verifiers may be 
busy people! 
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CHAPTER TWENTY-ONE 

iRECORD MOBILE APP 
Open the App.   

The opening screen shows any existing records. 

Tap the ‘+’ on the top right to add a new 
record. 

Start typing in a species name – choices appear 
as you type.  At any point you can select the 
appropriate species 

Then tap your species entry and the full data 
entry screen opens 

The location will be set automatically, based on 
your phone’s GPS location 

You can now enter location details by tapping Location – this opens a map showing your current 
location.  If you don’t want the satellite map you can tap the Layers icon (top right) and choose from 
Satellite, Ordnance Survey map or OpenStreetmap. 

 

You can add free text comments, 
abundance details (there is a slider to 
choose a number or a list of choices), 
Stage (adult etc) and Identifiers (if others 
have helped with the identification). 

 

If you want to add a photo – tap the 
camera logo at the bottom.  You then 
choose between taking a photo or 
adding one you’ve already taken on your 
phone. 
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SETTINGS 

Select the menu icon at the top left of the opening screen (three 
horizontal lines).  This opens the iRecord App menu.   

• Logout – does what it says 
• Statistics – shows your most frequently-recorded species 
• Settings App – opens the screen below.  This lets you 

o Submit all – sending in all your newly added records to the main 
iRecord site. 

o Remove all saved – lets you delete all the ones you’ve sent from 
your device 

o Training Mode – lets you use the phone App in training mode – 
as you can with the website App 

o You can turn on and off use of Grid References and showing the 
map grid  

o Manage Saved – lets you select, delete or edit your recently-
used locations 

o Grid Square Unit – can be set to monad (1km) or tetrad (2km) 
o Experimental features (not certain what this does, but I keep it 

turned on! 
o Reset – resets all of these settings to default 

• Help – this is the place to look if you need help using the App 

 

If you make an error and want to delete an 
entry, swipe the record to the left – you will 
then see a red waste bin.  Tap this to delete 
the record.  It will warn you if you haven’t 
sent it in. 

IMPORTANT NOTE – This app lets you 
add new records and edit them PRIOR to 
you sending them in.  Once you tap the 
arrow and send the record in to iRecord, 
you can no longer edit nor delete it on 
your phone.  You can only edit or delete 
it from the main web-browser-based 
App. 

 

           

       

Group-specific Apps 

There are currently Apps available for grasshoppers/crickets (Orthoptera) and butterflies.  These 
operate exactly as the general App, but have specific information to help you identify species 
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(including audio of grasshopper calls) and pictures.  Both Apps let you deselect areas of the country 
under settings.  This removes species that don’t occur in the region to make recording simpler. 

Both apps also allow more accurate recording of habitat and stage/age than the basic App, but are 
basically the same. 

Again – once the record has been sent in to iRecord, you can only edit it on the web-based site.  
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CHAPTER TWENTY-TWO 

DOWNLOADING DATA & REPORTS 
You can only download your own records.  However, you can download your full data set if you 
want.  You may want to do this occasionally to keep your own backup of your data.   

Click Explore – Download 

You then see the following screen. 

 

Download type has a dropdown offering ‘My records for reporting’ and options relating to any 
Activities that you have set up or joined.  For each of these you can choose between ‘My records 
added using a recording form for an Activity’ or ‘All records added using a recording form for an 
Activity’.  This is the only way you can download any records other than your own! 

Filter to apply – you can choose ‘all available records’ to get everything or use one of your filters 
that you created earlier on Explore pages. 

Survey to include – Leave this as <All> unless you want to restrict the records to one survey – an 
example is ‘iRecord > Earthworm Survey’.  

Date field – this allows you to choose which date field to filter by.  Choices are: 

1. Field record date – the date the record was made 
2. Input date – the date you entered the record onto iRecord and saved it 
3. Last changed date – the date you last altered and saved any changes to the record 
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4. Verification status change date 

Field record date The first will let you sort all records made in a particular period – for 
example all those made in 2018 

Input date will let you sort all records that you entered in a particular period.  This would 
enable you to send an updated list for a year of recording if you’ve added a few more 
records from your notebook for the same period. 

Last changed date is useful if you’ve already sent your records to someone for the previous 
year, but know that you’ve corrected a couple of identifications since. 

Verification status change date will let you find any changes made since a particular date.  
This may be of use on occasion. 

Start Date & End Date – These let you choose your period of interest.  Click on the box and you get 
the usual iRecord calendar to click on. 

Select a format to download – gives you the choice on 
the right. 

CSV and TSV are files used to transfer data 
between spreadsheets and databases.  CSV 
files are used as a standard way to import into 
spreadsheets such as Excel, LibreOffice Calc or 
Google Sheets.  You can sort and reformat 
them in a spreadsheet and then import them 
into other recording packages, such as MapMate and Recorder.   

Google Earth (KML) will download a file that can then be imported into Google Earth.  In 
Google Earth click File – Import – find and select your file.  All the records will then appear 
under - Temporary Places – Records.  Each will have a coloured square, a pin and a label 
(species name).  If you click on the species name either in the menu list or on the map – the 
full record will open in a window.  An example of a Google Earth import can be seen on the 
next page – the map can get quite busy, but I can see potential in reviewing for example 
where you’ve recorded froghoppers in the last 5 years?  It is quite fun and interactive. 

GPS track (GPX) – are files that can be imported into GPS software.  If you use a GPS App on 
your tablet or phone it would let you carry data around with you, which might be of value 
when in the field.   

NBN Exchange – is a format to allow records to be imported into the National Biodiversity 
Network.  This is for advanced users with access to the NBN, such as those running National 
Recording Schemes. 
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Other download options 

From the ‘Explore my records’ page you can apply a filter and/or sort the records.  In the bottom 
right-hand corner of the list it says ‘Showing records 1 to 20 of xx’ then ‘Download this report’.  If 
you click this it will download a CSV file with the default name of download.csv.  You can rename this 
and save it wherever you want.  It has a standard format (as below) in Species alphabetical order, 
but does not contain all of the data for each record – only the main elements.  As such it is of limited 
use when trying to export to other databases.  However, if you want a quick list of records filtered in 
some way it is perfect. 

 

You can also produce reports from the My sites screen. 

Choose a site and click the explore button next to it under Actions.  You will then see a list of all the 
records for the site.  In the bottom right corner, it tells you haw many records there are and gives an 
option to download this report.  Click this and you get another CSV file – format as above. 
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A quick note on other online recording and analysis systems. 

iSpot – this is primarily an identification site where users can post photographs for identification.   

iNaturalist – This is an international biological recording site.  Judging by the maps, it is particularly 
popular in the USA.  It offers about the only easy option if you wish to record observations outside 
the UK from travels or holidays.  It has a record verification framework consisting of ‘Casual’, 
‘Needing ID’ or Research Grade and is in many ways similar to iRecord in its aims.  At present there is 
no sharing of data between iNaturalist and iRecord, so you are probably best sticking with one or the 
other.   I prefer iRecord as it is currently the best way to feed data into the National Biodiversity 
Network (NBN) and National Recording Schemes.  However, at some point it is essential that the two 
work together, I think. 

Pantheon – Not an online recording system, but an analysis system for lists of invertebrates.  You 
can upload species lists and get reports from them, based on scarcity, habitat preferences and other 
criteria.  It is being added to and improved all the time.  Lists of species are all very well, but this 
software will help to evaluate them. I use it as a quick way to add value to species lists I send to 
site/conservation managers. 

IF YOU HAVE ANY FEEDBACK OR COMMENTS ON THIS DOCUMENT, PLEASE 
EMAIL ME AND I WILL UPDATE IT FOR FUTURE USERS. 

Steve Garland FRES – steve@stevegarland.co.uk 
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